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INTRODUCTION
Considered layout and careful creation will maximise long-term label use. M-
Design plus is an important design tool that gives the user a high degree of
design freedom and can be used to satisfy a wide range of labelling needs.  

M-Design plus programme users are carefully guided through each design
step.  Overview windows and menus simplify complex tasks and make it easy
to produce customised labels for every need.  For optimal label design, first-
time M-Design plus users are advised to follow the step by step procedures
described in this manual.  Experienced M-Design users should keep the
manual to hand for future reference.

In the event of difficulties, please contact your Domino supplier.
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GETTING STARTED
System Requirements
M-Design plus is a Windows based programme and requires an IBM PC or
compatible with the following minimum specification: 233 MHz processor,
64 MB RAM, and colour monitor (256 colours, 640 x 480 pixels).

It is important that the monitor has normal proportions and is not
compressed, as this is likely to affect the proportions of the label and make it
difficult to see what will be printed.

Installation
Windows XP: Double-click on the “M-Design Setup” file and select
English or Swedish in the language box.  The setup program will then guide
you through the installation.

Main View
M-Design is opened in the following view, displaying a blank label.

                    

 At the top of the screen is the Title Bar displaying the label name:
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Below the Title Bar is the Menu Bar:
                    

Below this are the formatting toolbars:
                    

The rest of this section gives an overview of the menus in M-Design plus; they
will be covered in more detail in a number of places further on in the manual,
as will the formatting toolbars.

File
In the File menu, it is possible to open, save, and print an existing label or create
a new label. You can also use the File menu to exit M-Design plus or to close
the currently displayed label window.

The print to file command creates a text file of the chosen label which includes
all information the printer needs to print the label. 

Settings
M-Design plus must be correctly configured with the printer(s) in order to be
used. Both the programme and the printer can be configured in the
“Settings” menu. This is generally only done the first time the programme is
used. Configuration of the programme is described in “Configuration” on
page 8.

Labels
In the Labels menu it is possible to create label lists that can then be sent to the
printer; see “Sending Labels List(s) to the Printer” on page 30 for more
information.

Graphics
In the Graphics menu it is possible to create graphics lists which can be sent to
the printer; see “Sending Graphics List to the Printer” on page 28 for more
information.

It is also possible to import and edit graphics stored on the PC/server; see
“Graphics” on page 7 for more information.

Text Editor
The Text Editor displays an overview of the information on the label. The text
editor is used for making text labels based on a template. See “Text Editor” on
page 26 for more information.
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Network
Use the Network menu to display a list of the printers connected to the
network. The menu is active only when communication mode is set to
Network in the Settings menu.

Format
The Format menu is used when handling TrueType fonts. It is possible to
create font lists that can be sent to the printer. 

Window
The Window menu contains options for viewing multiple labels
simultaneously.

Help
The Help menu contains a short Help section with instructions and an About
box that displays the version of the installed M-Design.

Configuration
When using M-Design plus for the first time it is important to configure the
software according to your specific needs. Open the Settings menu and select
PC Configuration to display the PC Configuration window. Below is an
explanation of the different PC Configuration settings (each of the displayed
images below shows the default settings in M-Design plus).

General
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It is possible to store labels and graphics anywhere on the PC/server. Use the
 buttons to set the correct path to the directories where the files are/will

be stored.

If M-Setup (printer configuration software) is installed on the PC, ensure that
the path to M-Setup is correct. When selecting Printer configuration in the
Settings menu, M-Setup will automatically open in a new window.

It is possible to select how many of the recently used files should be displayed
when opening the File menu.

Select which language to be used in M-Design.

Uncheck Show toolbar and/or Show rulers if you do not want them to be
displayed in the label window.

Check Associate .eti files with the program  to automatically open M-Design
when you double-click on them (label files created in M-Design are
automatically saved as .eti-files.).
Check Password to be able to strat the program limits label editing to authorised
staff. If the password is forgotten, contact your Domino supplier.

Select the default font to be used when adding new text strings to your labels.

Printer Settings
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M- Design must be correctly configured in order to work properly with the
printer.

Select PC Printer if you want to print your labels on any PC Printer (e.g. laser
or inkjet printer) connected to the PC. Click the Properties button to
configure the PC Printer.

Select Inline Printer if you want to print your labels on a M-Series printer.

Film printer must be selected if the M-Design F20 printer is used. The M-
Design F20 prints on packaging film.
Dots/ mm should correspond to the resolution of the printer to be used. The 
correct value must be selected if the screen is to show correct size of 
characters, graphics etc.

If Accuracy is set to dots, it is possible to place the strings on the label with dots
accuracy, instead of mm accuracy. This is normally used only on very small
labels, but if used it is important that the printer is configured for dots
accuracy as well.

If Transmit graphics with label is checked, all graphics on the label are sent to the
printer together with the label. It does not matter whether you send one label
or a long list of labels. 

Only one label list can be sent, as the graphics in the first label list will be
replaced by the graphics in the second label list. This option must be used if
the graphics are not stored in the printer. See “Sending Graphics List to the
Printer” on page 28 for more information on storing graphics in the printer.

Max compression of Graphics is used only if necessary. It reduces the file size of
the graphics thus enabling more graphics to be stored in the printer, and
reducing the transfer time.

If Transmit variable TrueType fonts with label box is checked, all variable
TrueType fonts on the label are sent to the printer together with the label.
The conditions are the same as described for Transmit graphics with label , above.
This option must be used if the variable TrueType fonts are not stored in the
printer. See “Sending Font List to the Printer” on page 28 for more
information on storing TrueType fonts in the printer.

Scaling of TrueType fonts and graphics is used if the same label is printed on
both 8 dots/mm printers and 12 dots/mm printers.
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Communication
                    

Select the means of communication between PC and M-Design Printer.

Local COM port should be selected for serial communication - it is important
to select the correct Com port used on the PC and to set the correct Baud
rate.

The RS485 Network box should only be checked when printers are linked to
a network. If RS485 Network is selected, the highest printer number in the
network should be given in the No of printers box. The response time should
also be given. This value could be set to 1 and changed only if necessary e.g.,
when communication is poor. 

The RS 485 converter is always used with an RS 485 network. However, there
are occasions when the converter is used without a network being installed,
e.g. when the computer and printer are very far apart. An RS 485 converter is
recommended when the distance is longer than 20 metres. 

If the printer is connected to an Ethernet using TCP/IP communication, the
correct IP address and port number must be given. Use the Test button to
check the communication.

If USB communication is selected, the correct USB printer must be selected.
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LABEL DESIGN
Creating Labels
To create a new label, open the File menu and select New to open the Label
size window. Enter the required width and height of your label and then click
OK. (The default figures in the menu are the length and width of the last label
created.)

                    

Adding strings
The label is created by adding strings using the toolbar shown below:

                    

Choose between the following string types:
                    

 Text strings

Barcodes

Graphic symbols

Inverse fields

Linked strings
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Text strings, Barcodes, Graphic symbols and Inverse fields can be made
dynamic by selecting the Dynamic check box. This function is used if string
data will be sent to the printer from an external system.

Text strings
To create a text string, click the text string button  to display the
following  drop-down list:

                    

When writing text strings, select one of the available font types from this
drop- down list; the default is font type 3: TrueType fix. All font types can be
used together on the same label.

Machine fonts
Font type 0, 1 and 2 are machine fonts which are permanently stored in the
printer; 0 is the smallest and is 5 dots wide and 8 dots high; 2 is the largest.
Machine fonts can be used for all text strings on a label.

True Type fonts
Font type 3 and 4 are TrueType fonts; 3 is fix and 4 is variable. Provided that
the character is available in the selected font, True Type fonts can be used to
print, e.g., Cyrillic or Greek characters.

Fix TrueType fonts are automatically sent to the printer as graphics together
with the label. Labels with fix fonts should only be used when the printer is
connected to a PC. It is recommended that fix True Type fonts are used only
for certain applications, e.g., when testing, as the label looks the same all the
time and functions such as date strings and sequential numbering cannot be
used.

Variable TrueType fonts can be sent to the printer, with or without the label(s).
Most commonly variable TrueType fonts are sent without the label(s), in a
font list created in M-Design. How to create a font list is explained in
“Sending Font List to the Printer” on page 28.

Date strings (including time and Best Before date)

Sequential numbering

Lines

EAN-SSCC
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Variable TrueType fonts must be used for text strings that will be changed
after the label is sent to the printer, e.g., date strings. 

The use of variable TrueType fonts allows more labels to be stored in the
printer than if fix TrueType fonts were used.

When variable TrueType font is selected for any text string, select which
TrueType font to use from the label’s drop-down font list and click OK (see
the following graphic).

                    

If the desired font is not available in the list, click New font to the list to open a
new window; select the required font to add and click OK. The window
displayed below will open, where all characters to be used with the font
should be specified. Characters can be added one by one by clicking on them
or by typing them in the input field. Click any of the buttons:

, , , , ,
and the corresponding characters will automatically be added. It is possible to
save a set of characters as default and then load this default set of characters
next time. 

                    

Fonts are, by default, sent to the printer in the 0° angle. When the printer
prints a text string in another angle it needs to rotate it internally before
printing it. This takes some additional time, so if the time between each print
is really critical, the font can be sent in the same angle as it is positioned on
the label.

Click OK and the addition of the font to the font list is automatically saved. 
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When the text string button  is pressed a formatting window will pop up
on the right side of the window:

                    

Select the desired angle of the text string. All text strings, barcodes, lines, etc.,
can be printed in four different directions on the label: 0°, 90°, 180° and
270°. An A, indicating angle, is shown alongside the number.

Click the Width up or down arrows to increase or decrease the font width.

Text strings, Barcodes, Graphic symbols and Inverse fields can be made
dynamic by selecting the Dynamic check box. This function is used if string
data will be sent to the printer from an external system.

Click the Truetype font button to select the required TrueType font. 

If machine font has been selected, the Truetype font button will not be visible. 

The Prompts button is reserved for use with special operator software.

Once the formatting has been completed, the string can be written. Move the
cursor to the point where the string is to be written and enter the desired
text. It is possible to edit and delete all strings after they have been added to
the label; see “Editing Labels” on page 25 for more information.

The position of the string on the label is determined by the x and y
coordinates in the reading field in the lower right corner of the screen. The
origin of the coordinate system is placed in the top right-hand corner of the
label. The direction of the label feed is along the x line. 

Barcodes
To create a barcode string, click the  button on the toolbar. 

A formatting window will pop up on the right-hand side.
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Select the angle of the barcode relative to the direction of print. All text
strings, barcodes, lines etc can be printed in four different directions on the
label; these are at right angles to each other and are described as 0°, 90°, 180°
and 270°.

It is recommended that the bars on a barcode are printed in line with the
direction of print, i.e., 90° and 270°. A slower print speed should be selected
if 0° and 180° are selected, as high speeds may result in wide, unreadable bars. 

Select the type of barcode and its Height in mm and Width in dots.

Text strings, Barcodes, Graphic symbols and Inverse fields can be made
dynamic by selecting the Dynamic check box. This function is used if string
data will be sent to the printer from an external system.

As standard the printer can print: 

• UPC A/E

• Code 128/EAN128

• EAN 20 (EAN 13 as a price code)

• EAN 8

• EAN 13

• Code 39

• Interleaved 2 of 5

• EAN/DUN 14
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A second window will also appear in which it is possible to make Barcode-
specific settings and enter the code text.

                    

However, instead of typing in the code text, the preferred method is to use
the barcode Link option in the formatting window (see page 16). In the link
table that appears, data can be linked to the barcode from other strings on the
label.

                    
MT27845 Issue 1 March 2007 17



There are advantages of linking label data to one or more barcodes:

• Linking saves time by removing the need for entering data in the barcode

• The risk of errors is reduced, as all information on the barcode is
guaranteed to be the same as the information in the strings linked to the
barcodes

• When transferring data from other systems to the printer, the data does
not need to be sent to the barcode, as this information is selected from
other strings on the label.

Graphics
Graphics can be logos, product symbols, warning marks, etc. 

Graphics must be black and white (line art, monochrome) and saved in any of
the following formats:

• .pcx

• .tif

• .dib

• .psd

• .png

• .bmp

To add a graphic to the label press the Graphics buttons,  and select the
required graphic from the drop-down list in the Graphics window that is
displayed.

                    

Move the cursor to the desired position on the label and left-click with the
mouse to add the graphic.
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It is possible to edit the graphic before adding it to the label; press the Edit
button in the Graphics window and the following window will be displayed:

                    

When satisfied with the editing, press Save as and save the edited graphic in
the desired directory and then add it to the label by clicking on the label.

Graphics which are to be used in M-Design should be stored in the directory
specified in the PC Configuration (see “Configuration” on page 8). It is
however, possible to import and use graphics stored in other directories by
using the Import Graphics function. 

This function is available in the window above (using the Import image..
button) as well as if Get/view graphics is selected  in the Graphics menu in the
toolbar; the Convert graphics window will then be displayed (see next page).
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The Get/view graphics submenu also allows editing of the graphics as well as
the deleting of them from the PC.

Inverse fields
An inverse field is a black field which, when placed over a text string, will
make the text white instead of black. 

Press  to create an inverse field and then place it over the text. Change the
length and width to the appropriate size in the formatting window that
appears on the right side of the screen.

Note: Always write the text first. If the inverse field is made before entering the 
text, the display will be incorrect

Linked strings
Press  to open the Linked string window:

                    

The drop-down list contains all strings already on the label and by selecting
any of these in the list and then clicking on the label, an exact copy will be
added to the label. It is possible to change format of the linked string, such as
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angle, but the information in it can only be edited by changing the string to
which it is linked.

There are advantages of using linked strings:

• Linking saves time

• The risk of making errors is reduced as the information in the linked
string is guaranteed to be the same as the information in the reference
string

• When transferring data from other systems to the printer, the data for
two identical strings does not need to be sent more than once.

Date and time strings
To create a date string, click the date button  in the toolbar. The box
Date and time field will be displayed:

                    

Select the required Type of Date/Time. Select which variables to include in the
string (e.g., day, month and year for a date string) and in which order they
should be displayed. In the Format list, select which punctuation marks to use
in the string. 

The other attributes of the string, i.e., angle, font and enlargement, will
follow the routines for text strings as described in “Text strings” on page 13.

When a date/time string is added to the label the real date/time is not shown
on the screen. The date/time string is displayed instead, so as to reflect the
selected format. The clock in the printer determines the exact date/time
when the label is printed.

If a Date Offset string is selected, specify the Date Offset date as the number of
days/weeks/months to add to the actual print date (default setting is days,
changes are made in the printer configuration - not in M-Design).
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On a single label it is possible to add only one Time string; whereas, it is
possible to add two different Date strings, and three different Date Offset
strings.

The other attributes of the date/time string, i.e., angle, font and enlargement,
will follow the routines for text strings as described in “Text strings” on
page 13. 

Sequential numbering
Sequential numbering is used for printing consecutive numbers on labels.
Sequential numbering counts up if the stop value is greater than the start value
and vice versa.

Global sequential numbering means that all labels printed by the printer use
the same counter. The opposite is label connected sequential numbering, i.e.,
each label has its own counter.

To create a Sequential No. string, press the Sequential numbering button 
in the toolbar to display the following window:

                    

Select the required type of sequential number to use. If Label connected
sequential number is selected, it is possible to change all parameters in this
window.

Increment by is the length of the step counted. This can be in either direction. 

No. of labels per step specifies the number of labels to be printed with the same
sequential number.
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If leading zeros are printed, the number of digits in the string always equals the
number of digits in the stop value. If leading zeroes are suppressed, the
number of digits in the string equals the number of digits in the current
counter value. For example, with leading zeros set to be printed, if the
number to be printed is “121” and the stop value is set to “99999", the string
will be displayed and printed as “00121”. If leading zeroes are set to be
suppressed, it will be printed as “121”.

Alignment has an effect only if leading zeroes are suppressed.

When the sequential numbering has reached the specified stop value, the printer
can:

• restart the sequential numbering from the specified start value

• continue printing with no seq. numbering, meaning that the string will be
blank on all subsequent labels 

• stop printing, until it receives new instructions/information from the
printer. 

It is possible to schedule the restart of the sequential numbering. At the
predetermined interval; once per day, week, month or year, the sequential
numbering returns to its start value.

If global sequential numbering is selected, no changes can be made in the
Sequential No. window. Open the Settings menu and select Global sequential
numbering to make the settings for the global sequential number. These
settings must then be sent to the printer by using the Transmit to printer button.

Lines
A line can be created by clicking the Line button  in the toolbar. 

Selecting the desired angle as 270° results in a horizontal line on the screen,
with its starting point on the left-hand side of the label.

Enter the desired length and width of the line. Length is given in mm and
width in dots. The maximum length is 296 mm and maximum width is 24
dots.

EAN-SSCC
An SSCC, or Serial Shipping Container Code, is a standardised 18 digit
number allocated to uniquely identify a logistics unit. It is most commonly
used on outer cases and pallets.

The number is normally created from the company prefix, followed by a serial
reference, totalling 17 digits. The eighteenth digit is a check digit.

The EAN-SSCC function in M-Design allows easy creation of an SSCC
number in accordance with EAN standards.
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To create an SSCC number click  on the toolbar and then Link SSCC, in
the window that is displayed on the right-hand side of the screen, to display
the following window:

                    

Firstly, select Digit or space in the Type column in row 1, and enter the
company prefix in the String column. The No. of characters in the right column
will automatically increment as digits are added in the String column.
Depending on how many digits are in the company prefix there will be a 
varying number of “free” digits available for making the SSCC number 
unique. A total of 17 digits should be entered, as the eighteenth digit, the 
check digit, is automatically calculated and added. 

Below is an example of how a typical SSCC number is created:
                    
24 MT27845 Issue 1 March 2007



Editing Labels
Editing strings
Click the arrow button  in the toolbar, click on the string to be edited
and a red frame will appear around the string. It is now possible to change all
of the settings that were selected when the strings were added, as well as move
the strings around by dragging and dropping or by using the arrow keys on
the keyboard. If dots accuracy is required and selected in the PC
Configuration (see “Configuration” on page 8) hold the “Shift” key down
whilst moving the cursor with the arrow keys.

More than one string can be edited at the same time. Hold down the “Shift”
or “Ctrl” key and click on each of the strings to be edited. The last of the
strings selected will have a darker frame, indicating that this string will be the
reference when using the alignment functions.

Double-clicking a text string will allow the text in the string to be edited,
whereas a single click makes it possible to change angle, font, width and size. 

Deleting strings
Click the arrow button  in the toolbar and then click on the desired string
on the label. Click the delete button , or press “Delete” on the keyboard.
It is possible to delete more than one string at a time.

Changing a string number
Click the arrow button  in the toolbar and then click on the desired string
on the label. Click Change String Number button , and then enter the
desired string number in the pop-up window.

This function is used to sort strings once they have been entered; i.e., the
string number can be determined after entering the data.

Moving the label area
By clicking Move Label Area , all strings on the label can be moved
simultaneously.

Rotating a label
By clicking Rotate Label , the label can be rotated to 0°, 90°, 180° and
270°. This function is particularly useful when the label is to be printed
upside-down. 

Changing the size of a label
By clicking the button for changing the label size  you can adjust the label
size in the same way as described in “Creating Labels” on page 12.
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TEXT EDITOR
In the Text editor the label is represented in a list displaying all strings in a
structured manner. This can be useful for getting an overview of the order
and types of strings on the label, and the possible links between the strings.

It is possible to open labels stored in any directory by browsing the directories
in the left-hand pane. All label files in the selected directory are listed in the
Label drop-down list.

To the right of the Label drop-down list are two radio buttons indicating
whether the selected label is a Layout label or a Text label (see below for an
explanations of these terms). If it is a text label the narrow Layout box displays
to which Layout label the text label is connected. 

The text editor only allows editing of text information in the strings.
                    

Layout Labels
An ordinary label designed in M-Design is saved as a layout label. Layout label
files contain all information about the strings on the label, such as positions,
font types, rotations, etc. This means that a layout label file is relatively large,
limiting the number of labels that can be stored in the printer.

Text Labels
The text editor is used for creating text labels – as text labels take up far less
memory space, this allows more labels to be stored in the printer. 
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Firstly, a layout label is created and used as a template. Using this template,
hundreds of text labels can be created in the text editor and subsequently
stored in the printer. The text label files contain only text information, but
they will have the same appearance as the layout label to which they are
connected. The only difference will be the information in the strings.

To create a text label connected to an existing layout label, select the layout
label in the text editor (see the Text editor screen displayed above). Click Save
as and name the file before saving. In the Select label type window check the
Text label radio button and select to which Layout it should be connected.
Press OK and a text label is created. Now change the text information in any
text string or barcode string and finish by saving the changes. The text label
will automatically be saved in the same directory as the layout label. It is
important that the layout label used as a template is stored in the same
directory to which it is connected.

When a text label is opened in the main window, no changes can be made.
The only possible changes to an individual text label are text changes and they
are made in the text editor. All changes of font types, string positions, label
size, etc., are made on the layout label and then automatically applied to all
connected text labels.
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SENDING LISTS TO THE PRINTER
Storing TrueType fonts, graphics and labels in the printer saves a lot of time.
Instead of having to send them before each print they are sent to the printer
once, and then selected manually or automatically, and quickly retrieved from
the printer’s memory.

When TrueType fonts, graphics and labels are to be stored in the printer they
must be sent to the printer in lists.

Sending Font List to the Printer
If any string on the labels to be printed is using Font type 4: Variable
TrueType font, it is necessary to send this font to the printer before printing
the labels.

Open the Format menu and select Fontlist. M-Design can handle ten different
font lists, which can be displayed in the window below. It is however only
possible to store one font list in the printer, so select the correct list, ensure
that it contains all fonts that will be used printing the labels and click the
Transmit list button. 

Depending on the number and size of the fonts in the list, and the
communication speed, transmission can take anything from a few seconds to a
few minutes.

Note: The font list must be transmitted to the printer before the labels.
                    

Sending Graphics List to the Printer
Graphics can be sent together with the labels, but it is recommended that
graphics are sent to the printer in a graphics list.
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Open the Graphics menu and select “Lists”. M-Design can handle fifteen
different graphic lists, which can be displayed in the window below. It is
however only possible to store one graphics list in the printer.

                    

In the window above, the Graphics pane on the left lists all supported graphics
files stored in the “Graphics” directory defined in the PC Configuration (see
“Configuration” on page 8). These files are added to the list to the right by
clicking on them. There are 100 positions/rows in each graphics list, but
depending on the size of the graphics it might not be possible to store this
many in the printer.

The graphics will be arranged in the same order in which they are added to
the list; also the same order in which they are saved in the printer. This order
is important only if graphics will be selected by commands from an external
system. 

Note: Each graphic will be stored in the printer with a storage number one lower 
than its row number in the list, e.g., “ce2.pcx”, in the above display, will 
be stored as number 0 in the printer

Graphics are, by default, sent to the printer in the 0° angle. When the printer
prints a graphic in another angle it needs to rotate it internally before printing
it. This takes additional time, so if the time between each print is really
critical, the graphic can be sent in the same angle as it is positioned on the
label.

To save a list, select the required list number from the fifteen buttons situated
above the list and then press Save list. The list will automatically be saved as
Gx.lst (where x is the selected list number, 0-14) in the same directory as the
graphics are stored.
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Click Transmit list to send the graphics list to the printer. 

Note: The graphics list must be sent to the printer before any label list.

Sending Labels List(s) to the Printer
Storing the labels in the printer has many advantages and is used frequently.
Labels to be stored in the printer must be sent to it in label lists. 

Open the “Labels” menu and select “Label List” to display the screen below.
M-Design can handle 15 different label lists and all of them can be sent and
stored in the printer. However, if more than one label is sent with the same
storage number, only the most recently sent label will be stored.

                    

When the label list window is opened all labels stored in the “Labels”
directory specified in PC Configuration will be displayed in the list. It is
possible to browse through the directories to the left and open any other
directory.

• The first column in the list displays the name of the label file, with the
extension excluded.

• The second column displays the storage number – this has to be given
each label before it is sent to the printer. 

• The third column indicates whether the label is a Layout label file or a
Text label. If it is a Layout label file, “LAYOUT” will be displayed in the
third column; if it is a text label, the Layout label file to which it is
connected will be displayed.
30 MT27845 Issue 1 March 2007



Whatever the name of the label file, it will be stored in the printer together
with the storage number assigned to it in the label list. It is possible to give a
label any storage number between 1 and 999999999. It is common practice to
use numbers starting from 1, or, if the labels contain an article number, to use
the article number as a storage number. 

Click the  button to copy all digits from the file name in the first
column to the storage number in the second column.

To change or delete a storage number, move the cursor to the storage number
box, click with the mouse on the storage number and press backspace or
delete on the keyboard, and/or enter a new storage number.

If the “Delete label” option is used, the label will be deleted from the PC.

To save a list, click any of the List no buttons to allocate the label a number
between 0 and 14. The list will then be saved automatically as Lx.lst (where x
represents the allocated number between 0 and 14) in the directory in which
the labels are stored. 

Use “Delete list” to delete a saved list. This will not delete any labels.

In the example above, not all labels will be sent to the printer. To view the
“real” label list, click “View list” to open the  View list window (see below),
showing only those labels with a storage number. This window also presents a
summary of the number of Layout labels in the list and the total number of
labels (Layout labels + Text labels). 
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